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INTRODUCTION

Thank you for your purchase of LINEEYE's protocol analyzer. To use it correctly, you are advised to read
and understand this instruction manual thoroughly. Keep this together with the warranty. If you encounter any
problems, you will find helpful information in this manual.

NOTICE
■ It is prohibited to reprint or duplicate any part or the whole of this instruction manual without prior permis
sion from LINEEYE.
■ The contents of this instruction manual and specifications of the products are subject to change without
notice.
■ This instruction manual has been designed and edited with great care to give you all necessary information.
If you have any questions, feel free to direct your inquiries to LINEEYE CO., LTD.
■ LINEEYE assumes no responsibility whatsoever for any damages resulting from the use of this product.
Furthermore, LINEEYE makes no guarantee of data etc. when data disappears, or even when the recorded
data has broken while using this product.

USER LIMITATION
This product has been developed for the purpose of using as an analyzer only, and has not been developed for the
use that needs exclusively high reliability and safety; aerospace apparatus, trunk communication apparatus, nuclear
control apparatus, medical apparatus related with life maintenance and etc. Also, this product does not warrant the use
for those purposes. If you use for those purposes, please consider the safety measures against fail-safe etc. on your
responsibility.
This product has Wi-Fi function (IEEE 802.11b/g/n) and emits radio wave when working. Please do not use near
a medical device, microwave, high-level electronics, TV, radio, wireless station for mobile communications, or
specified low power radio station. Where an administrator limits the use of radio devices, follow the instruction of the
administrator.
SIMPLIFIED EU DECLARATION OF CONFORMITY
Hereby, LINEEYE declares that the communication protocol analyzer type LE-200PR / LE-150PR with radio
remote-control function is in compliance with Directive 2014/53/EU.
The full text of the EU declaration of conformity is available at the following internet address:
http://www.lineeye.com/html/contactus.html
Wi-Fi AVAILABLE COUNTRIES
The Wi-Fi function of the analyzer is available only in Japan, USA, Canada, and the EU nations where the product
needs to be conformable to RE directive (2014/53/EU) for use.
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Safety Information
Read this first ! !
This Safety Information includes the important information in order to not only have you learn the right way to use the
analyzer, but also prevent you from causing damage to people and property. Before using, please read the main contents after
you understand the following contents (symbols and marks).

[Explanation of the symbols (The degree of the hazard factor)]
WARNING
The symbol denotes that improper handling poses a risk of causing death or serious injury.
CAUTION
The symbol denotes that improper handling poses a risk of causing injury*1 or damage to the
product and property*2.
*1: “Injury” indicates injury, burn, an electric shock, or the like which does not require
hospitalization or the extend over a long period of hospital visit.
*2: “Damage to the product and property” indicates damage expansion related to a house, a
building, furniture, apparatus, livestock or a pet.

WARNING

■ Do not disassemble or modify.
This may result in fire, an electric shock and/or unit malfunction.
■ Stop using the analyzer immediately when smells emanate from itself.
Continuous use may result in an electric shock, a burn and/or fire.
■ Keep the products away from water.
Failure to do so may result in the heat generation, an electric shock and/or unit malfunction.
■ Do not short-circuit the connector pins.
This may result in the heat generation, an electric shock, unit malfunction and/or injury.
■ Do not use deteriorated cables (damage etc.).
This may result in the heat generation and fire.
■ Do not use in the place which generates inflammable gas etc.
This may result fire.

CAUTION

■ Do not use and keep this product in the following places:
● The places exposed to the direct rays of the sun.
● The places with the humidity and temperature exceeding the tolerance level, and with
a rapid temperature change.
● The places with much dust and moisture.
● The places near the objects which generate heat (the heater etc.).
Using in these places may result unit malfunction and /or injury.
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Software License Agreement
LINEEYE CO., LTD (LINEEYE) grants you to use the software program and accompanying documents under terms of this
license. And you are consenting to be bound by and are becoming a party to this agreement. To use the software, you need to
agree to this license agreement.
1. Copyright
LINEEYE holds the copyright on this software.
2. Grant of License
LINEEYE grants for you to use this software on only one computer by getting the software and agreeing this license
agreement. Therefore, you shall not rent, lease and loan to a third party.
3. Copy, Analysis, Modification
This software must not be reproduced, analyzed or modified in any form unless prescribed in the manual.
4. Upgrade
This software may be upgraded without advance notice because of technical progress of hardware or software.
LINEEYE provides software upgraded by payment specially. For upgrade, only licensed user can have upgrades.
5. Limitation of Liability
In no event shall LINEEYE or its licensors be liable for loss of business or profits, or for any direct, indirect, incidental
or consequential damages arising from products of this software or the related software. Besides LINEEYE shall not be
liable damages arising from the equipment or the medium.
6. General
If any provision of the agreement is held invalid, such provision shall be removed from this license agreement.
7. Support
LINEEYE supports functions, operation and only the problem on this software.
8. Notice
Any matter not specified in this agreement will be governed by and constructed in accordance with copy right law and
related laws.
								

LINEEYE CO., LTD.
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Chapter 1 Before Using the Product
LE-150PR/LE-200PR are the RS-232C/RS-422/RS-485 communication analyzers, which can be used as
PC-connectable protocol analyzers and PC-less data logger. With PCs, these analyzers can be used as high
performance protocol analyzers and have On-line monitoring function and Simulation function. Without a PC,
they can be used as data loggers and record data in the SD cards.

Wi-Fi function is available only in Japan, USA, and Canada.
1.1 Composition
When you unpack the product, please make sure of the following
Protocol Analyzer: 1
Utility CD (CD-ROM): 1
SD card (8GB): 1
Mini USB Cable: 1
DSUB 25pin monitor cable (Model: LE-25M1): 1
External Signal I/O cable (Model: LE-4TG): 1
Instruction Manual: 1 (This book)
Warranty Customer Registration Card: 1
* Please contact LINEEYE distributor or us if you find any insufficient part or any damage to the product
caused by transportation.
* Please keep the box carefully to use it when sending the product back to us for repair etc.
● Utility CD
Contain the analysis software, driver and some instruction manuals for the analyzers and its options. You
can download the update file of software of our products from https://www.lineeye.com.

1.2 Outline
■ Functions
1) On-line Monitoring
Monitor the transmission / reception data on-line to check for existence of hindrance in the line or to
analyze the communication.
2) Simulation
Operate transmitting / receiving data as a communication partner for test devices.
3) Data Logging
Record data in the SD card automatically without a PC.
■ Feature
		 * PC-connectable protocol analyzer and PC-less data logger.
		 * Support arbitrary speed (any four digits). (Max.500Kbps : LE-150PR, Max.1Mbps : LE-200PR)
"→10-3 Specification of Analyzer”
		
		

* Support RS-232C/RS-422/RS-485 interface without any options.
* Measure transmission/reception data along with idle time, time stamp and line status.

		

* Record measured data continuously in the HDD of PC or SD card. (Max.8GB: HDD, Max.16GB: SD
card)
* Specify the recording time by Real Time Clock.
* Powerful trigger function controls the external signal output and user defined LED.

		
		

		 * Simulation function sends registered data with one press of a key.
		* Compact size. Able to used the 35mm DIN rail.
		

* Remote monitoring is possible by Wi-Fi connection.

		* It is possible to receive the logger files while measuring by Wi-Fi connection.

" → 8-3 Receive the logger files by Wi-Fi connection.”
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1.3 Explanation of Each Part
4)

1)

5)
6)
7)

8)

3)

2)

1). Measurement Interface
The measurement interface consists of a DSUB 25pin connector connectable over RS-232C or RS422/485 target devices.
2). External Trigger I/O Terminal
This terminal is used for external I/O signals for the operation of the analyzers in synchronization with
external devices, such as measuring instruments. Use the included trigger cable (LE-4TG) to connect.
3). LED
POWER/ERROR: Indicate the operating status of analyzer.
RUN/ACT: Indicate that analyzer is measuring or accessing to the SD card.
POWER/
ERROR
Light off

RUN/ACT

Light off
Light off
Green light
Green light
Red light
Orange light
Light off
Green light
Green
Orange light
blinking
Red light
Orange light
Light off
Green light
Red blinking
-

Status
Power Off
Protocol Analyzer Mode

Logger Mode

Ready to operate
Measuring
Accessing to the SD card (*1)
Measuring and Accessing to the SD card (*1)
Ready to operate
Measuring
Ready to start measuring

Firmware Update Mode
Error

Accessing to the SD card (*1)
Measuring and Accessing to the SD card (*1)
Self-check error, Unusual error (*2)

		*1: Do not remove the SD card while lighting.

		

*2: Contact LINEEYE distributors or LINEEYE for support.

SD/RD: Indicate the status of SD line (green light) and RD line (red light).
Voltage level of signal line
RS-232C
RS-422/485
+3V ≤ VM
VA - VB > +0.2V
VM < +3V
VA - VB < +0.2V

LED
Light
Light off

VM: Voltage level of RS-232C
VA: Voltage of RS-422/485 (A line)
VB: Voltage of RS-422/485 (B line)

		U1/U2: Able to light the U1 (green) /U2 (red) by trigger actions.

		

Wi-Fi : It lights in green when the analyzer connects with an access point of Wi-Fi.
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4). RUN/STOP Switch

Press to start measuring. Press for a while to stop measuring.
5). SD Card Slot
Insert the SD card as the following figure.
To remove the SD card, press the SD card and it will come out from the analyzer.

6). USB Connector
Use the included USB cable to connect the host PC.
<Dust-proofing cover>
There is a dust-proofing cover on the SD card slot and USB connector. To change the SD
card, open the cover as following.

Also, it is possible to open the cover for USB connector side only as following.

7). DC Jack
Connect the power supply when using the analyzer as a Data Logger.
Optional DC plug cable (SIH-2PG) is useful.
DC plug type: center-plus, outside diameter 5.5mm, inside diameter 2.1mm
8). M3 Screw Hole
This is for connecting the analyzer on the DIN rail. Pitch: 70mm. Depth: 3.5mm (max)
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Chapter 2 Installation
Install the analysis software to the PC you are going to operate the analyzer.
Install the USB driver when connecting the analyzer to the PC at the first time.

2.1 System Requirement
PC/AT Compatible (DOS/V)
HDD: 20MB + capacity for recording communication log
OS: Windows 7/8.1/10
Port: USB port
SD card drive: It is required for the Logger Mode to save log files and configuration settings.

2.2 USB Driver Installation
When using by USB connection, you need to install the USB driver on the PC.
1. Do not connect the analyzer to the USB
port of PC before the driver installation.
2. Download the USB driver compatible with
the analyzer from the LINEEYE website,
Unzip to a proper folder. (The driver is also
included in the CD attached to the product.) Supported OS are Windows 10/8.1/7
3. Execute setup.exe in the folder.
4. “User Account Control” appear in the
display of the PC. Then click “Yes”.
5. “LINEEYE driver package installer”
appears. Then click “Yes”.

6. “Device Driver Installation Wizard” appears. Then click “Next”.

7. Windows security window appears. Then
click “Install”.
8. If the window says “Completing the Device
Driver Installation Wizard”, click “Finish”.
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9. Connect the analyzer device to the PC. The
installation is completed.
is the installation for Windows
Above
10. It will be almost same for other
Windows OSs.

2.3 Installation Guide
■ Install
1. Execute “setup.exe” in the attached CD.
If the PC (to which you want to install the software) does not have a CD-ROM drive, copy it to a storage
device such as USB flash using another PC which has a CD-ROM drive to bring it to the PC and execute it.



2. First, click “Yes” in the “User Account Control” display.
3. When the Windows firewall displays a message such as “Windows protected your PC”, click “Detail”“Run” to run the program.
4. Even if the virus security software displays a message that blocks this software, click the option to run
the software such as “Run this program” to cancel the blocking.
5. When the installer starts up, proceed according to the instructions on the screen.
You will be prompted for the serial
number during installation. Please enter
the serial number of this software written
on the attached user registration card.

6. When the installation completion message is displayed, click “Finish”.
■ UnInstall
1. Open “Uninstall or change a program” (or “Program and Features”) from the control panel. (Or rightclick on “LE-LINK20R” in the start menu and select “uninstall”.)
2. Select “LE-LINK20R” from the list and execute “Uninstall and change”.
3. First, click “Yes” in the “User Accounts” display.
4. Click “OK” at the deletion confirmation display.
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2.4 Setting for Wi-Fi
To use Wi-Fi function of LE-150PR/ LE-200PR, you need to power the analyzer after inserting SD card in
which Wi-Fi configuration file (WLAN CFG.WL) is written.
< How to make a Wi-Fi setting file >
1. 1. Click「LE Wireless LAN configuration」from the start menu..
2.Select Station or Access point and set the items to be required.

■Station Mode

The analyzer connects with Wi-Fi via access point.
SSID			 : Set the SSID of the access point to be connected.
Password		 : Set the password of the access point.
IP address		 : Set the IP address of the analyzer.
Subnet mask : Set the subnet mask of the analyzer.
Gateway		
Port number

: Set the IP address of the gateway when you use it.
: Set the data port of the analyzer.

■Access Point Mode
The analyzer turns to be an access point and connects with Wi-Fi.
SSID			 : Set the SSID of the analyzer.
Password		 :Set the password of the analyzer.]
IP address

:The IP address is fixed to 192.168.4.1

Channel		 : Set the channel to be used for Wi-Fi connection.
Port number : Set the data port to be connected.
* DHCP server function is set to valid in the access point mode.
You can use "Automatically obtain IP address" in the network setting of PC.
3. Press Save.
4. Insert the SD card in which Wi-Fi setting file is written into the analyzer.
5. Power the analyzer.
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Chapter 3 Basic Operation
3.1 Connection
■ Protocol Analyzer Mode
1). Connect the analyzer with the PC in which the software is installed via USB or Wi-Fi.
2). Connect the analyzer with the target line by using LE-25M1 or LE-5TB.

Dsub25
(female) (male)

PC

Dsub9

DCE

Dsub25

DSUB 25pin Monitor
cable(LE-25M1)

(male)

Use LE259M1(option)
it the target device
has the Dsub pin
connector

Connect to the USB port

Dsub25 (male)

■ Logger Mode
1). Connect the DC plug cable (SIH-2PG) or AC adapter (6A-181WP09) to the analyzer.
2). Insert the SD card, which saved the configuration settings of the analyzer.
3). Connect the analyzer and target devices using the LE-25M1 or LE-5TB.
Dsub25
(female) (male)

PC

Dsub25

(male)

Use LE259M1(option)
it the target device
has the Dsub pin
connector

DCE

DSUB 25pin Monitor cable(LE-25M1)

<SHI-2PG>
Connect the black/white
cable to the positive electronic
pole of DC power.

Power-cable
(SHI-2PG)

SD card

<External power supply>
・External power supply range for DC IN is from DC7V to 34V.
・Consumption current of LE-150PR/LE-200PR is about 145 mA when Wi-Fi is used and about
90mA when
Wi-Fi is not used.
・Suitable DC plug is center plus 5.5mm (outside) / 2.1mm (inside).
Connect to the target devices
		 * RS-232C
		 1). Target device has Dsub 25pin on RS-232C: Connect as above figure using the monitor cable
		(LE-25M1).
		 2). Target device has Dsub 9pin on RS-232C: Connect using the optional cable (LE-259M1).
			 Attention: RS-232 undefined terminals of Dsub 25pin are supplied some other signals. Do not
						 allocate power supply of more than 6V to its 9/10/11/12/13/18/19 pin using DSUB
					 25pin monitor cable (LE-25M1). It may cause the product malfunction.
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(12, 13, 15, 17th pins are only for LE-200PR.)
* RS-422/485
			 Connect to the RS-422/485 pin of the Dsub 25 connector.
		 19 pin ------ TXD ( - )
		
		

18 pin ------ TXD ( + )
13 pin ------ RXC ( - )

		
		
		
		

12 pin ------ RXC ( + )
13 pin ------ RXD ( - )
10 pin ------ RXD ( + )
7 pin ------ GND

			

Terminal block adapter (LE-5TB) is useful to measure SYNC communications on RS-422/485 pin.

			 To measure external clock ASYNC (using RXC), you need to modify the Dsub 25pin cable by
			yourself.
		

-----Full Duplex (RS-422/485)-----

Device A

Device B

Device
			

[Connection for Monitoring]			
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[Connection for Simulation]

			

-----Half Duplex (RS-485)-----

Device A

Device B

Device A
				

[Connection for Monitoring]			

[Connection for Simulation]

Terminal Control

Terminal Control
LE-150PR/LE-200PR does not have the terminal control. To

120ohm 1/2W

connect terminal controls on the analyzer, use the external
controls (120Ω 1/2W) and put together with the signal lines.

120ohm 1/2W

Terminal Control
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3.2 Configuration of Analysis Software
■ Data Window
Execute the analysis software
From [Start] menu of Windows, go to [All programs] -> [LINEEYE] -> [LE-LINK20R]. Execute “LELINK20R” and then following display will be appeared.
1). Menu
Perform various operations
2). Tool Bar
Perform various operations
3). Data Display
Display the measured data

1) →
2) →

3) →

4). Data Position Display
Display the data name and data position of data
in the Data display. The number of data loss
will be displayed while monitoring.
5). Function Display
Display selected function.
(Monitor or Simulation)

↑
4)

↑		
5)		

↑
			
6)		

↑
7)

6). Status Display
Display the status of measurement.
7). Model Name Display
Display the model name of the analyzer.
■ Connection Settings
Click “

” on the tool bar of the data window (or “Measurement” -> “Connection setting”) and set the

connection settings and data saving settings.
The Connection settings consist of “Connection”, “ Model selection” and “Measurement data”.
*“Connection” page
Setting for connection
“How to connect”
Select the connection method with the analyzer from USB or
LAN/Wi-Fi(TCP/IP).
Wi-Fi function is available only in Japan, USA, and
Canada.



“Serial number”
This is the number to distinguish multiple units of the analyzer. The list shows the analyzer which is connected with
the PC but not used.
“Host name”
Setting for the IP address of the analyzer to be connected via
Wi-Fi.

“Data port”
Setting for the port number to be used for data sending/receiving
* Model Selection
		 Select the model to be connected.
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* Measurement Data
Select the saving folder and file size of measured data.
[A folder to save the measured data]
This folder is for saving the measured data.
To change the settings, click “Change” button.
Then the window to select a folder will be appeared. Select the proper folder and click “OK”.
The file name of saving data is started from
“0000000.DT” in numerical order.
* Recommend specifying an exclusive folder.
* Specify a drive, which has enough capacity.
(When it does not have enough capacity, the
PC may not operate correctly.)
Attention: If there is not the folder in the place you specified, a message dialog will be appeared.
[Block Size]
Set the data capacity per file. You can select from 1M/2M/4M/8M/16M byte.
* Analyzer consumes 4byte per one sampling.
[Max Block Count]
Set the maximum block number of a file to save. You can set from 2 to 1024.
When the number of the data file is over than that, the data file with the lower number will be deleted.
[Full Stop]
If the stored files reach to the maximum block number, it will stop measurement automatically.
If you do not select it, the analyzer records data continuously as a ring buffer.
[Append Mode]
When measurement starts, a newly-created file is saved in the order after the existing files. If the number of
the whole data files are over the maximum block number, a data file with the lower number (includes data
files which were saved on the former measurement) will be deleted even in the append mode. If you do not
select it, the former data will be deleted and start the file name from “0000000.DT”.
[Change file by elapsed time]
Change the recording file when the specified time has passed even though it does not reach the specified
block size. If there is not any data in the file, it will not change the file.
[Warning Display]
It warns that there is the former data in the file you specified as saving file.
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■ Analyzer Settings
Click “

” on the tool bar of the data window (or click “Measurement” -> “Measurement setting”) to set the

protocol, speed and so on. On the measurement setting window, every time you change the setting on the left
side of the window, the contents of the setting (on the right) will be different. Click “
configuration as a “.SU” file. Click “

” to save the

” to read the configuration file.

* Function
MONITOR “ONLINE” Select when monitoring. SIMULATION “MANUAL” Select when simulating.

* Interface
Select “RS-232C” or “RS-422/RS-485”. Select “DTE” or “DCE”mode on the RS-232C port for simulation.

* Data Monitor
[Configuration]: Set the protocol and speed of target devices.
[Record Control]: Add the information recorded along with transmission/reception data.
[Trigger]: Set the trigger conditions and actions.
* Simulation Data Table
Register the transmission data in HEX.
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Chapter 4 Interface Setup
Select a port for monitoring. And, select output specifications for simulation.
Click “
” after setting.

■ Port
Select from RS-232C or RS-422/485.
* Mode
Select DTE or DCE mode for simulation.

* Polarity
Select the signal polarity of data. Normally
selects “NORMAL”. “INVERT”will invert
all the signal polarity.

* Driver Control
Select when using RS-422/485 port.
[OFF]: Driver is always active.
[Manual]: Driver becomes active while ER signal is active.
			
(Set “
” from the “operation panel”)
[Auto]: Driver becomes non-active right after it starts simulating and then becomes active while
			
		

transmitting data. (Driver becomes active right before it starts simulating and becomes nonactive after transmission.)

■ Output Option Power
Set when using the optional TTL monitor probe pod (OP-5M). It supplies DC 5V for OP-5M from Dsub 9pin
connector.
			 Attention: Set the port setting to “RS-232C” in the case of using “OP-5M”. Do not set for simulation.
			
■ Auto Line Control
Control line status of signals on RS-232C port.

* DTE
③

①
②
1). RS ON
2). SD Send
3). RS OFF
ER ON

Meaning
Time between it starts sending and RS becomes ON.
Time between CS becomes ON and it sends data to SD.
Time between SD ends sending data and RS becomes OFF.
Fix status of ER signal. ON: "High". None: "Low".
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* DCE

①
②

③
④

1). CS ON
2). CS OFF
3). CD ON
4). RD Send
5). CD OFF

⑤

Meaning
Time between RS becomes ON and CS becomes ON.
Time between RS becomes OFF and CS becomes OFF.
Time between it starts sending and CD becomes ON.
Time between CD becomes ON and it sends data to RD.
Time between RD ends sending data and CD becomes OFF.
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Chapter 5 Monitor Function
The purpose of the monitor function is to record communication data into files without affecting the communica-

tion lines. Also, it is to display data clearly following each communications protocol. Not only communication data
but also time stamp for data frame and idle time are recorded. As a result, error time and time out conditions are
investigated. Moreover, the trigger function, which detects specific communication, is included.

5.1 Communication Condition
Click “

” on the tool bar of the data window (or click “Measurement” -> “Measurement setting”). Set

the communication condition for target devices.
* Protocol
Select from ASYNC*/SYNC*/HDLC/
PPP(ASYNC).
* Supported only by LE-200PR.
* Speed
Set any speed (Any 4 digit number).
* Data Code
Set the data code.
* Parity
Select from parity bit or multiprocessor bit.
<Protocols and setting items>

* Stop bit
Set a stop bit length. Set only for
simulation.
* Bit Sequence
Set the order of bit transmission.
In order to check normal protocols,
selects “LSB First”.
* Frame End Time
Set the time of non-communication
state of ASYNC, which judged as a
frame end. Set when adding the time
stamp.
* Frame End Character
Set the frame end character of
ASYNC, which judged as a frame end.
Set when adding the time stamp.
* Clock
Select a synchronism clock for SYNC
and HDLC from ST1/ST2/RT/AR. If

Speed
Data Code
Data bit
Parity
Stop Bit
Bit Sequence
Frame End Time
Frame End Character
Clock
SYNC Code
Reset Code
Suppress
BCC
Begin Code
End Code
ITB Character Code
Address Filter

ASYNC
●
○
●
●
○
○
○
○

○
○
○

SYNC
●
○
●
●

●
●
●
○
○
○
○
○

SD Address

●

○
○
○
○
○

Frame
Packet

○
○

○
○
○
○

●: Necessary settings. ○: Need to set for special measurement.
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○

○
○

Flag Suppress

selecting “AR”, it adjusts the clock for
monitored data.

PPP
●
○

○

RD Address
Format
FCS
Transparent
DLE Code
Idle Mode
Leading Flag
Translation Protocol

HDLC
●
○

○

* SYNC code
Set a synchronism settle data for SYNC.
* Reset Code
Set a synchronism reset code for SYNC. Set “FF”for normal operation.
* Suppress Code
When codes set in this section are monitored continuously, the second code and after ones are not stocked in
the memory.
* BCC
Set a block check code for ASYNC and SYNC.

Calculation start character Calculation and character

* Begin Code
Set a calculation start code for block check.
* End Code
Set a calculation end code for block check.

Calculation range

BCC

Calculation start character ITB character Calculation and character

* ITB Code
Set an ITB (intermediate-text-block) code.

Calculation range

Calculation range

* Address Filter
Set a frame address (8 bits right after a flag) on the SD/RD side through HDLC. To receive all frames, sets
“don’t care (*)”.
* Format
Set a transmission code for SYNC/HDLC.
* FCS
Set a frame check sequence for HDLC/PPP.
* Transparent
Set on/off of transparent mode when calculating block check.
* DLE Code
Set a DLE (Data Link Escape) code for transparent mode.
* Idle Mode
Select an idle state between frames through HDLC simulation.
* Leading Flag
Set the number of leading flags through HDLC simulation.
* Packet
Set translation specifications of frame level for HDLC. Select frame level or packet level.
* Flag Suppress
When flags are monitored continuously through PPP, the second flag and after ones are not recorded in the
memory.
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5.2 Start and Stop measuring
■ Start Measuring
” on the tool bar of data window (or click “Measurement” -> “Run measurement ”). “Measuring”

Click “

is displayed in the status display, and display data from the analyzer on the screen. Click “
the font size, and “
ing “

” to change

” to change display in HEX while measuring. Also, it can pause the display by click-

”.

■ Stop Measuring
Click “

” on the tool bar of data window (or click “Measurement” -> “Stop measurement”). It is possible

to scroll data after the measurement. Data will be save into the specified folder set in the configuration
settings. To open the previous files, click “

” (or “File” -> “Open data file”) and specify the file. When

opening more than one files, it will display as sequential data.

■ Display
“

”: Transmission data
(SD/TXD+-/TR+- of interface).

“

”: Reception data
(RD/RXD+- of interface)

If there is data on SD and RD at the same time, data will be displayed in the same column.
“ ” indicates the position of latest data and only displays while measuring.

“

” indicates the idle time (non-communication time). For example, if you set the idle time resolu-

tion as “10ms”, it indicates that there is 34.4 seconds of non-communication time.
“

” indicates the time stamp (frame reception time). For example, if you set the time stamp

resolution as “Min/Sec/10ms”, it indicates the frame was received at 10 minutes 13.73 seconds.
=> [7.3 Record Control]
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■ Error Data and Special Character
Code

Name

Meaning

Parity Error

Displayed when parity is incompatible

Framing Error

Displayed when stop bit is "0".

Parity & Framing Error

Parity error and framing error are generated at the same time.

Break

Displayed when all of start bit, character bit, (parity bit), stop
bit are "0".

Block Check Code (Normal)

Displayed when BCC or FCS is normal.

Block Check Code (Abnormal) Displayed when BCC or FCS is abnormal.
Multi-processor Bit

Displayed when multi-processor bit is “1”. (*1)

Loss Data

Displayed when there is loss data because of the ability of PC/
SD card, or speed/amount of data.

Recording disable

Displayed if not recording in the capture buffer by the capture
control function.

Recording enable

Displayed if starting the record in the capture buffer by the
capture control function

*1: Data will be displayed in red. Character data excepting multi-processor bit will be displayed in
HEX. If multi-processor is “0”, it will be the normal character data.
*

Click “

” (HEX display) to check the actual data of special codes.

■ Display data property
Click [File] -> [Show data property] to display the start/stop time of measured data, firmware version,
configuration and so on.
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■ Display each frame in different line
Click [Data monitor (Frame view)] tab to display frame divided by time stamp for ASYNC/SYNC
communication.

■ Translation Display
For HDLC/PPP measurement, “Data Monitor (translation view)” tab will be added.
[PPP Translation]

Item
Time
Protocol
Code
ID
FC
Data

Meaning
Shows the frame receiving time.
Translates and displayes the protocol.
Translates and displayes the code field value.
Displays the value of identifier field in decimal.
Displays the frame check.
Displays data.

● The analyzer translates all bits of ACCM as “0”.
		

(Example) All bits of ACCM are ON (1) between communications equipment.
Terminal Device (DTE)

Terminal Device (DCE)

Transmitted data over a circuit

Recognizable data in reception
7F FF 03 21 31 32 33 7E

7F FF 03 21 31 32 11 33 7E

“11” is not processed as recognizable data.
Translation
7F FF 03 21 31 32 11 33 7E
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[SDLC/SDLCE/X.25/X.25E Frame Translation](LE-200PR)

Item
Time
Addr
Type
NS
PF
NR
FC
Data

Meaning
Shows the frame receiving time.
Displays the contents of address field in HEX.
Displays the frame type in the form of mnemonic.
Displays the frame sequence number in decimal.
Displays the logical value of P/F bit.
Displays the frame sequence number in decimal.
Displays the results of frame check.
Displays the data in the information field.

[LAPD Frame Translation] (LE-200PR)

Item
Time
SAP
TE
CR
Type
NS
PF
NR
FC
Data

Meaning
Shows the frame receiving time.
Displays the value of service access point identifier in decimal.
Displays the value of termination point identifier of terminal in decimal.
Displays the value of Command Response display bit.
Displays the frame type in the form of mnemonic.
Displays the frame sequence number in decimal.
Displays the logical value of P/F bit.
Displays the frame sequence number in decimal.
Displays the results of frame check.
Displays the data in the information field.
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[X.25 Packet Translation] (LE-200PR)

CN
Time
GN
CN
Type
PS
NR
M
Q
D
FC
Data

Meaning
Shows the frame receiving time.
Indicates the logic channel group number in decimal.
Indicates the logic channel number in decimal.
Displays the packet type in the form of mnemonic.
Displays the packet sequence number in decimal.
Displays the packet sequence number in decimal.
Indicates the logical values of more data bit.
Indicates the logical values of qualifier bit.
Indicates the logical values of transmission verification bit.
Displays the results of frame check.
Displays the data.

[LAPD Packet Translation](LE-200PR)

CN
Time
PD
Message
CRF
CR
FC
Data

Meaning
Shows the frame receiving time.
Displays the protocol identifier in HEX.
Displays the contents of message type in the form of mnemonic.
Displays the value of nominal number flag.
Displays the value of nominal number in HEX. (Max 2 octet)
Displays the results of frame check.
Displays the data.
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Chapter 6 Simulation
The simulation function is the tool that makes the analyzer operates as a counterpart to the test devices even if
the target devices are not prepared, and that executes a test for transmission and reception following protocols. A
margin can be evaluated at staggered communication speed on purpose because appointed communication speed
can be set. Moreover, error-processing response can be checked with tested data, which includes parity error data.
Also, RS/CS (ER/CD) control lines can be added (ON/OFF), and there is a powerful trigger function to have the
response test. Click “

“ to save the configuration in “*.SU” format, and click “

“ to read the configuration

file.

6.1 Preparation for Simulation
“Click “

“ on the tool bar of data window (or “Measurement” -> “Measurement setting”). Register the

transmission data in the data tables.

There are 16 data tables (0-F tables) and total of 16KB data can be registered.
● <Registration Data>
The character, which are inputted and displayed, can be set in the configuration menu. The character of
registering transmission data cannot be changed by SHIFT IN and SHIFT OUT.
*
*

Parity bit will be transmitted automatically and it is not necessary to register it in the data table.
The effective data entered is only bit which is set in the character bit length. Others at higher
positions will be ignored.

● <Method of Registration>
1). Registered data will be displayed on the screen. A cursor position is where “ “ is blinking. On the
		 upper right of the screen, it will show the position and rest of buffer of transmission data.
2). Date Entry:
”) or character (“

”). Move a cursor where you wish to enter data

		

Input data in HEX (“

		

using a cursor key. To modify or add entered data, move the cursor to the position and enter the
characters.

		

To delete it, move the cursor where you wish to delete it, and press [Delete] key. Then, it will be

		

deleted, and the characters after the deleted character will be moved forward.

		

To set the parity error or multiprocessor bit, move “
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” to the place where you wish to have them

and click “

”. To cut or copy into the clipboard, select data and click “

” or “

clipboard, move the cursor to the place you wish to insert the data and click “

”. To past from the
”.

6.2 Data Transmission
Click “

“ on tool bar of data window (or “Measurement” -> “Measurement setting”) and select “Simulation

(Manual)”.

Item
Delay Time
Repeat
Idle Time
1). Click “

Description
Space between characters
Repeat transmission of frame
Interval of repeat transmission

“ on the tool bar of the data window (or “Measurement” -> “Measurement setting”). It will

make the following control lines active, and will be in a wait state till the key corresponding to the
transmission data table number is entered.
		
DTE setting: RS, ER / DCE setting: CS, DR, CD
2). Select a data table.
Click “

“ on the tool bar of the data window. Click a data table number makes to transmit the

registered data.

When “Repeat” function is ON, data
corresponding to the data table will be transmitted
continuously spacing for idle time.

● In the case of RS-232C simulation, control lines can be set as following.
: RS/CS: ON/OFF of RS (CS) line.
						
: ER/CD: ON/OFF of ER (CD) line.
						 Data transmission will not be affected by controlling the control lines.
● To stop the repeat transmission function, click “				 ”.
					

*
*

If there is nothing registered in the data table, it cannot start transmission.
If “Table 2” is selected to send while “Table 1” is sending, transmission of “Table 2” will start after

finishing transmission of “Table 1”.
Even you select the idle time to “0” and select repeat transmission function, it will take some time
for processing.
* If the analyzer is set as the DTE setting and “Auto Line Control” is ON, CS of target device has to
*

be ON.
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Chapter 7 Useful Functions
7.1 Trigger Function
Trigger function is to start a specific action upon occurrence of a specific event as the trigger. A perplexing flow
of data, which is not easy to be analyzed in the normal monitor operation, is analyzed on the basis of occur
rence of the specific event. Click “

“ on the tool bar of the data window (or “Measurement” -> “Measurement

setting”). And then open the trigger setting.
Up to four triggers can be set.
Trigger factor and action can be
set for each trigger independently.
Each trigger can be set either to
be enable or disable.

*

Trigger Factor
Four kinds of trigger factors can be set.
1) Error
Trigger action will take place by the
generation of an error.

2) Character
Trigger action will take place by the
generation of specific characters. Up to
8 characters can be set for either of SD/
RD sides. “*”(don’t care) and bit mask (3
kinds) can be set.

*
		
		

For example, the trigger action will take place by the generation of “ABC” or “aBC” in the RD side
in ASCII code. Using the bit mask makes it possible to set the capital/small letter setting, such as
“A (41h)” and “a (61h)” in ASCII code.

3) Line
Trigger action will take place by a status
(1(High), 0(Low) or *(don’t care)) of
each signal line. There are RS, CS, DR,
CD, ER, CI and EX (trigger in) signal
lines.
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4) Timer/Counter
Trigger action will take place when the timer or the
counter reaches a preset value.
5) Idle Time
Trigger action will take place when the idle time
reaches a preset value.
Idle time has to be set in the “Record control” and the resolution of idle time should be the same as the
one in the “Record control”
*

Trigger Action
Four kinds of trigger actions can be set.
1). Stop
Measurement will be stopped automatically. Delay
time from the occurrence of the trigger to the stop
of measurement can be set.
		Quick: Stops the measurement immediately as trigger occurs.

		

Before: Stops the measurement after capturing 6K characters after satisfaction of trigger.

		
		

Center: Stops the measurement after capturing 128K characters after satisfaction of trigger.
After: Stops the measurement after capturing 250K characters after satisfaction of trigger.

2). Timer
Specify the timer number to be controlled and the
type of control (start, stop, restart).

3). Counter control
Specify the counter number to be controlled and
the type of control (increment, clear).

4). Trigger control
The status of other trigger is set when trigger
event is occurred. Sequential trigger action can be
set.
* “Change” makes “Disable” to be “Enable”, or “Enable” to be “Disable”.
5). Send data
Send the data table, which you registered. Select
the table number.
		

Delay (response time) from the occurrence of a trigger before the start of data transmission can be
set in the range of 0 to 99.999sec.

6). Trigger Output
Approx. 1ms Low pulse is outputted from the TRIGGER_OT2
Approx. 1ms Low pulse is outputted from the TRIGGER_OT1 after
satisfaction of all triggers. (not related to Trigger Output setting.)
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7). LED Out
Light ON/OFF the specific LEDs. It is useful to
check the measurement in visual during the data
logger function.

8). Capture control
Select “Enable (recording)”, “Disable (not
recording)”, or “Change the state (Enable<>Disable). If selecting “Disable”, monitored data
will not be recorded as log data.

7.2 Timer/Counter
The Timer/Counter function, in conjunction with the trigger function, measures the elapsed time since a spe
cific factor occurred, and counts the number of occurrences of a specific factor.
Clicks “

“ on the tool bar of the data window (or “Measurement” -> “Measurement setting”). Sets the

Timer/Counter setting.

7.3 Record Control
Additional information along with the data can be transmitted and received during the measurement.
Clicks “

“ on the tool bar of the data window (or “Measurement” -> “Measurement setting”).

Set the Record Control settings.
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* Idle Time
Idle time which is in mark state (no communication time) can be measured. In ASYNC, idle time between
frames indicate that the time between the last stop bit and next start bit.
* Time Stamp
This function can record the time when the top character of each frame transmitted through on the communication line. The analysis software will read the time of PC at the beginning of the measurement and
record the time stamp. For example, “Min/Sec/10ms”is selected at the configuration. “35:23:08” indicates
the frame was received at 35 minutes 23.08 seconds.
Time stamp will be recorded in the analyzer based on the calendar clock of the PC. Please make
sure your clock of the PC is correct before starting the measurement.
Example)
Idle Time: 10ms

1)
2)

Time Stamp: Min/Sec/10ms
1). The arrival time of the HDLC
frame on the SD line is 21 minutes
35.01 seconds
2). Time between the last SD line
data “ ”and top RD line data
“ ” is 100ms.
The decimal point is based on
the resolution of time stamp
setting.

* Line State
When the voltage level is more than 3V, it is displayed as “H”. And the voltage level is less than 3V, it is
displayed as “L”.
Example)
Idle Time: 1ms
Time Stamp: Min/Sec/10ms
1)

2)

3)

4)

1). Time between the beginning of
measurement and RS becomes
active is 5.281seconds.
2). Time between the RS becomes
active and CS becomes active is
5ms.
3). Time between the CS becomes
active and the top of frame “T”
is 102ms.
4). The top of frame “T” is arrived
at 13 minutes 09.42 seconds.

* Capture control (State at the start of measurement)
Select the recording state to the capture buffer at the start of measurement.This setting is used with “capture
control” function in the trigger action. For normal use, please select “Rec. enable”.
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7.4 Text Conversion
Measured data can be converted into text file or CSV file.
Clicks “

“ on the tool bar of the data window (or “Tool” -> “Text Conversion”).

* Format
Select from “Normal”, “with line
state”, “Translated”, “CSV format
(data)” or “CSV format (frame)”.
* Signal Line
Select from “SD/RD”,”SD only ”, or
“RD only”.

* Data Format
Select the data format from “Character/HEX”, “Character” and “HEX”.
* Line width
Select the number of characters per line. Select from “40”, “80”, “136” or “Max”.
* No Guide
If selecting this, configuration will not be recorded. (Data only)
* Exclude Time Stamp
If selecting this, time stamp will not be recorded.
* Exclude Idle Time
If selecting this, idle time will not be recorded.
* PPP Translation
If measuring PPP, select from “PPP” or “Dump”.
* HDLC Translation
If measuring HDLC, select from “frame” or “packet”.
* Control Line
Select the control lines to display along with data when selecting “with line state”.
The order of recording control lines can be set by [Forward]/[Backward] key.
■ Execute Conversion
Select the monitor data files and click “				
folder.
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” button. Converted file will be save in the selected

[Normal printing]

[Normal printing with line state]

[Translation printing (PPP)]

[Dump printing (PPP)]
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Chapter 8 Logger Mode
According to the configuration settings in the SD card, analyzer can record data for long hours without a PC.

8.1 Preparation of Logger Mode
Execute the “LE-LOGGER20R” from start menu -> “All programs” -> “LINEEYE” -> “LE-LINK20R” ->
“LE-LOGGER20R”.
■ Select the model type
■ Select the configuration for Data logger
mode.
1). Select the interface.
2). Select the configurations according
		 to the target devices.
3). Select the trigger conditions if
		necessary.
4). Select how to save the data.

		

* Saving Mode
		 “Restart”: 			 Delete the existing files first, and then start measuring from the file name of “#0000000.
										 DT”. Record data as a ring mode. (Delete the oldest file when the number of files
reaches to the “Max Files”.)
		 “Max-stop”: Delete the existing files first, and then start measuring. Stop measuring when the number
										 of files reaches to the “Max Files”.
“Append”: 			 Existing files will not be deleted. Record data as a ring mode. The file name will be
the sequence number after the existing files.
Select “Append” for normal operation. Especially when you use Auto RUN/STOP function, or in
the condition of [Run] key can be pressed accidentally, select “Append” mode.

		

* Max Files
* For 2GB SD card, the max file number to save will be 512.

			 Set the max number of files to save.
		 * File Size
			Select the file size to save.
			 “Max Files” x “File Size” will be the capacity of logging data.
			

Consider the actual memory capacity of the SD card.

							 For example). 2GB SD card: 1.8GB, 8GB SD card: 7.4GB.
Reference of Recording time (Max Files: 450, File Size: 4M byte)
Speed (bps)
Recording Time
In the case of 1KB data with 1ms interval is
9600
115.2K

Approx. 120 Hrs
Approx. 5 Hrs

transmitted in full duplex.
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* File change time

		

Change the recording file when the specified time has passed even though it does not reach the specified

		

block size. If "0" is selected, it will not change the file.
115.2K

Approx.5 Hrs

5). Click “File” -> “Save”and save the configuration in the SD card. When you save the file, name it “LE150PR#.
SU” for LE-150PR, and “LE200PR#.SU” for LE-200PR. Before starting the measurement as a data logger
mode, read the configuration file to the analyzer.

Make sure the configuration file is set properly to measure data. It is recommended that you check
the configuration by using “LE-LINK20R” first.
<Attention>
LE-150PR/LE-200PR supports 16GB SD card. The analyzer will not start operation if using
above capacity of the SD card.

8.2 Start and End of the measurement
■ Start Measuring
1). Connect the analyzer to the target device.
2). Insert the SD card, which saves the configuration (LE150PR#.SU/ LE200PR#.SU) of the analyzer.
3). Supply the power to the analyzer using the power cable (SIH-2PG) etc. LED of POWER/ERROR will
be lighting in orange.
* The analyzer will not record data if there is not the SD card with configuration data.
4). If Auto Run function is set, LED of RUN/ACT will be lighting in green. If setting the date of Auto Run,
the power will be supplied at 1 minute before starting the measurement, and LED of RUN/ACT will be
lighting.
* The configuration will be sent to the analyzer when switching on the power of analyzer. Even
you change the SD card after switching on the power, the measurement will start according to the
configuration of SD card which was set when switching on the power of analyzer.
If you do not use the Auto Run function, you need to press the RUN/STOP button.
* Make sure to check the light of LED of RUN/ACT after clicking the RUN/STOP button.

■ End Measuring
1). Click the RUN/STOP button if LED of RUN/ACT is lighting in green.
2). The last data will be recorded in the SD card of analyzer after stopping the measurement. If the analyzer
is accessing to the SD card, the LED of RUN/ACT lights in red.
* Do not remove the SD card or power supply while analyzer is accessing to the SD card.
Time stamp information is based on the time of RTC (Real Time Clock) embedded in the analyzer.
RTC is set when the product is released from the factory. And also when
connecting it to the PC by Remote mode, RTC is set according to the time of the PC.
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8.3 Receive the logger files by Wi-Fi connection.
In logger mode, log files in the SD card can be transmitted to PC via Wi-Fi using “LE file downloader”
(ledatadownload.exe).
When you use this function, you need to make the Wi-Fi function valid by uploading the configuration file
and Wi-Fi configuration file (WLAN CFG.WL) made at “LE Wireless LAN configuration” into the SD
card which is to be inserted to the analyzer.
1 Input the IP address and port number.
2. Click “Connect” and the list of log files
appears. Click “Update list” and the latest
ones are displayed on the list window.
3. Select the file on the list window.
		 Note:
			 You cannot download the file which is in
			 logging. It will be error. Please note that
			 the file with the biggest number maybe
			 the file in logging.
4.
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Click “Download” and the selected files
are saved into the folder set at “A folder to
Store”.

8.4 Auto Run/Stop Function
The analyzer can start/end measuring at the specified date. Set “Auto RUN/STOP” using the “LELOGGER20R”.
* Mode
[Monthly]:
		 Start measuring at the specified time
		 every month.
[Daily]:
		 Start measuring at the specified time
		 every day.
[Hourly]:
Start measuring at the specified time
every hour.

* Run time
Specify the starting time of the measurement. The power will be supplied at 1 minute before starting the
measurement.
* Stop time
Specify the ending time of the measurement. The power will be turned off after the measurement
automatically.
* Power On Run
Start measuring when powering on the analyzer. Select from “Safely start “ or “Quick start”. For normal
operation, select “Safely start”. Safely start will start measuring approximately 40 seconds after powering
on the analyzer for charging the capacitor for back-up data.

8.5 Use of Log files
Log files will be named as “xxxxxxxx.DT”(“x” will be the sequential number).
These files can be analyzed by “LE-LINK20R”.
1). Insert the SD card to the SD card drive of the PC.
2). Click “

“ button, (or “File” -> “Open files”) and select the SD card drive. If you open more than one

files, it will be displayed as sequential data.
3). After analyzing the log file, click “File” -> “Close”.
* Do not remove the SD card while opening more than one files,
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Chapter 9 Update Firmware
You can update to the latest firmware by the PC, which installed the USB driver. Check the version of analysis
software (LE-LINK20R) from “Help” menu. The latest firmware will be available from the LINEEYE website.
Connect the analyzer to the PC and execute “LE-LINK20R” and follow the instruction.

■ Update Firmware
Click “Tool” -> “Check firmware”of the “LE-LINK20R”.
If you need to update it to the latest firmware,
following dialog will be displayed.

1). The version information of new firmware will
be displayed.
2). Click [Next].

3). A note for updating firmware will be dis
played.
Read it carefully and click [Start].
The firmware loader will start operating. The
LED of POWER/ERROR will be lighted Off
and LED or RUN/ACT will be lighted On
while the firmware loader is operating.

4).
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If the updating process is completed,
“Complete” will be displayed. And the
firmware loader will end the operation
automatically.

Chapter 10 Specifications
10.1 Interface (RS-232C/422/485)
Dsub 25pin connector is for RS-232C and RS-422/485 port.
Signal definition of RS-232C
Signal
Shield ground
Signal ground
Transmission data
Receiving data
Transmission request
Capable of transmission
Terminal ready
Data set ready
Data carrier detect
Call indicator (*1)
Transmission clock 2 (*4)
Reception clock (*4)
Transmission clock 1 (*4)

RS-232C (V.24)
DSUB25
Pin (*2)
FG
1
SG
7
SD
2
RD
3
RTS
4
CTS
5
DTR
20
DSR
6
DCD
8
CI
22
ST2
15
RT
17
ST1
24

Signal Input/Output (*3)
MONITOR SIM-DTE SIM-DCE
I
O
I
I
I
O
I
O
I
I
I
O
I
O
I
I
I
O
I
I
O
I
I
I
O
I
I
O
I
O
I

Signal definition of RS-422
RS-422
DSUB25
Pin (*2)
Signal ground
SG
7
RXDB (+)
10
Receiving data
RXDA (-)
11
TXDB (+)
18
Transmission data
TXDA (-)
19
RXCB(+)
12
Reception clock (*4)
RXCA(-)
13
Signal

Signal Input/Output (*3)
MONITOR
SIM
I
I
I
I
I
O
I
O
I
I
I
I

Signal definition of RS-485
Signal
Signal ground
Transmission /
Reception

RS-485
DSUB25
Pin (*2)
SG
TR (+)
TR (-)

7
18
19

Signal Input/Output (*3)
MONITOR
SIM
I
I

I/O
I/O

*1: CI signal cannot be output form the analyzer
*2: Signal pins which are not defined here are not connected.
*3: “I” indicates an input to the analyzer. “O” indicates an output from the analyzer.
*4: LE-200PR only.
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<Attention>
Signal pins which are not used for RS-232C (Dsub 25pin) are used for RS-485 signal. Do not
connect the target products which have more than 6V on the 9/10/11/12/13/18/19 of Dsub 25pin
connecter. It will cause the product malfunction. To connect such products, remove the pins of the
monitor cable which will be connected to the analyzer.

10.2 External Input/Output Terminal

(2) (1)
(4) (3)

Pin No.
1
2
3
4

Signal name
TRIGGER
OT1
TRIGGER IN
TRIGGER
OT2
GND

Function
Open drain output, +5V, 10K ohm pull up

Color of LE-4TG
Red

TTL level input, range: -0.5V to 6.0V

Brown

Open drain output, +5V, 10K ohm pull up

Orange

Signal ground

Black
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10.3 Specifications of Analyzers

Interface

Protocol

Memory

Model
RS-232C(V.24)
RS-422/RS-485
TTL
ASYNC
ASYNC PPP
Character SYNC
(SYNC/BSC)
Bit SYNC (HDLC/
SDLC/X.25)
HDD of the PC

LE-150PR

LE-200PR
◎
◎
〇
◎
◎

-

◎

-

◎
16GB

SD card

16GB

Speed range

50bps ～ 500Kbps
50bps - 1Mbps
Baud Rate (*1)
Freely set to four effective digits
Setting
(margin of error: +/- 0.01% or less)
Online monitor function
Record data without affecting the communication lines.
Simulation function
Transmit/receive the specific data in DTE/DCE mode.
5 of two colored LED: Power/Error, Test/Record,
LED
SD/RD, User defined U1/U2,Wi-Fi
Switch
One: Run/Stop
External trigger
One Input, Two Output, 2.54mm pin header connector
SD Card interface
2 - 16Gbyte SD/SDHC card(*2)
USB 2.0 Port
Mini-B connector, High speed supported
IEEE 802.11 b/g/n
Frequency range : 2400MHz-2483.5MHz
Wi-Fi Connection(*3)
TX POWER: 802.11b: +20dBm 802.11g: +17dBm
802.11n: +14dBm
Remote mode: USB bus power
Remote mode with Wi-Fi / Logger mode: External DC
power (DC 7 to 34V, supplied from the DC jack or 25th
Power (*4)
pin of DSUB connector), AC adapter (6A-181WP09).
Power consumption: 1.8W (0.8W when Wi-Fi is OFF,
Max.2.2W for about 10sec after turning on).
0.15W/DC24V when turned off.
Usual time: max. 1.2 W
Power consumption
When shutdown: max. 0.15 W
Run time during power failure
1 sec
Ambient temperature
In operation: -10 to +55℃ , In storage: -20 to +60℃
Ambient humidity
20 - 85% RH (no condensation)
Dimension, Mass
86(W) x 130(D) x 30(H) mm, Approx. 220g
Environment of PC
OS: Windows 7/8.1/10, PC: PC/AT compatible
*1: In the Logger Mode, the full duplex communication at 250Kbps without any pause may cause the
		 data loss in the SD card.
*2: Only SD/SDHC cards sold or attached by LINEEYE are supported.
*3: The Wi-Fi function of the analyzer is available only in Japan, USA, Canada, and the EU nations where
the product needs to be conformable to RE directive (2014/53/EU) for use.

10.4 Options
* Wide input AC adapter: 6A-181WP09: Power supply for Logger Mode, DC 9V center (+)
* Power plug cable: SIH-2PG: External power supply
* DSUB 9pin monitor cable: LE-259M1: To monitor through Dsub 9pin over RS-232C
* Terminal block adapter: LE-5TB: To connect to RS-422/485
* TTL monitor probe pod: OP-5M: To monitor TTL level signal
* DIN rail mounting plate: LE-DIN13: To connect analyzer on the 35mm DIN rail.
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Chapter 11 Warranty and Repair
Warranty
* This product package contains a warranty.
*

Read the warranty and keep it in the safe place.

Repair
*
*

LINEEYE will repair the product according to the warranty.
After the warranty period, LINEEYE will repair the product for you to use the functions properly at your
own expense. If your product needs to be repaired, please tell us the model name, serial number, purchased
date, and the details of problems.

---User Registration--Please register your products from our website or a registration card packed
with the products. We will provide you the update information and so on.
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There is a registration page on our web site.
( https://www.lineeye.com )
Please register your product for further support.
We will provide you the firmware update information
and sales information etc.

LINE EYE CO., LTD.
4F., Marufuku Bldg., 39-1Karahashi Nishihiragaki-cho, Minami-ku,
Kyoto, 601-8468 Japan
Phone: 81-75-693-0161

Fax: 81-75-693-0163

URL https://www.lineeye.com Email :info@lineeye.co.jp
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